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INTRODUCERE – CADRUL GENERAL

In conformitate cu Regulamentul de organizare şi desfăşurare a examenului de absolvire/licenţă/diplomă la Universitatea Româno-Germană din Sibiu, examenul de licenţă constă din două probe:

a) evaluarea cunoştinţelor fundamentale şi de specialitate;

b) prezentarea şi susţinerea lucrării de licenţă. 

Fiecare student al Facultăţii de ştiinţe economice şi calculatoare are obligaţia de a-şi alege tema lucrării de licenţă şi cadrul didactic coordonator, respectând, pe parcursul elaborării şi prezentării lucrării, cerinţele impuse de acesta.

Elaborarea lucrării de licenţă impune luarea în considerare a următoarelor cerinţe:

· domeniul (tema) cercetat(ă) să fie corelat(ă) cu specializarea universitară a absolventului;

· să asigure absolventului posibilitatea opţiunii pentru cercetarea acelui segment de activitate în care are cele mai profunde cunoştinţe generale, de specialitate şi faţă de care manifestă interes;
· să existe posibilităţi de informare suficiente.

Coordonarea lucrării de licenţă revine în responsabilitatea cadrelor didactice având cel puţin titlul de lector doctor. Coordonatorul ştiinţific al lucrării de licenţă are următoarele obligaţii:

· elaborează împreună cu studentul cuprinsul lucrării de licenţă;
· consiliază studentul ori de câte ori acesta solicită;
· apreciază calitatea conţinutului capitolelor elaborate şi face observaţii şi sugestii de completare sau de reconsiderare, acolo unde este cazul;
· analizează conţinutul integral şi forma finală a lucrării;
· întocmeşte referatul de apreciere a lucrării de licenţă în finalul căruia recomandă susţinerea acesteia în faţa comisiei examenului de licenţă şi propune acordarea unei note.
Studentul are următoarele obligaţii:

· analizează tema lucrării de licenţă pentru care a optat şi identifică problemele principale de soluţionat;
· prezintă coordonatorului ştiinţific proiectul de plan (cuprins) al lucrării;
· elaborează, împreună cu conducătorul ştiinţific cuprinsul lucrării.

· respectă problemele înscrise în cuprinsul lucrării, orice modificare ulterioară a acestuia fiind făcută cu acordul coordonatorului ştiinţific.
· solicită consilierea coordonatorului ştiinţific ori de câte ori apar dificultăţi în elaborarea lucrării de licenţă;
· prezintă coordonatorului ştiinţific, la termenele stabilite, părţile elaborate din lucrare;
· prezintă lucrarea de licenţă coordonatorului ştiinţific înainte de copertare, pentru ca acesta să aibă posibilitatea să mai facă observaţiile ce impun completări şi/sau modificări;
· predă, în termenul stabilit, 2 (două) exemplare din lucrarea de licenţă persoanei responsabilă cu centralizarea acestora.
Prezentul Ghid pentru redactarea şi prezentarea lucrării de licenţă (numit în continuare Ghid) este un document adoptat de către membrii Catedrei de ştiinţe economice, având următoarele obiective: 

· eficientizariea activităţilor de coordonare a lucrărilor de licenţă; 
· facilitarea redactării corecte de către absolvent a lucrării de licenţă;
· creşterea nivelului calitativ al lucrărilor de licenţă;

· evaluarea unitară a absolvenţilor care îşi susţin lucrarea de licenţă.   
În vederea atingerii obiectivelor enunţate anterior, prezentul Ghid conţine:

· informaţii referitoare la structura lucrării de licenţă (capitolul 1);

· reguli de redactare a lucrării de licenţă (capitolul 2);

· reguli de prezentare a lucrării de licenţă (capitolul 3);

· grilă de evaluare a lucrării de licenţă (capitolul 4);

· şabloane utilizate pentru redactarea lucrării de licenţă (anexe).

Prezentul Ghid va fi utilizat ca instrument de lucru al Catedrei de ştiinţe economice începând cu sesiunea de licenţă iulie 2009. 

Ghidul, împreună cu şabloanele utilizate pentru redactarea lucrării de licenţă, va fi publicat pe site-ul universităţii (www.roger-univ.ro) şi va fi aplicat de către cadrele didactice coordonatoare şi studenţi.

CAPITOLUL 1 

STRUCTURA LUCRĂRII DE LICENŢĂ
Lucrarea de licenţă are două părţi: teoretică şi aplicativă. Conţinutul lucrării de licenţă va fi structurat pe capitole şi subcapitole, dar nu mai mult de 4 grade de titluri, fiind incluse următoarele elemente obligatorii:

a. Copertă – informaţiile care trebuie să apară pe coperta lucrării de licenţă sunt prezentate în Anexa nr. 1;

b. Pagina de titlu – informaţiile care trebuie să apară în pagina de titlu a lucrării de licenţă sunt prezentate în Anexa nr. 2. De asemenea, absolvenţii pot descărca de pe site-ul Facultăţii de ştiinţe economice şi calculatoare şablonul pentru redactarea paginii de titlu;

c. Cuprins – lucrarea de licenţă va avea un cuprins care să conţină titlurile tuturor capitolelor şi subcapitolelor însoţite de numărul paginii la care începe fiecare dintre acestea (a se vedea exemplul din Anexa nr. 3);

d. Introducere – aceasta va conţine motivaţia alegerii temei, gradul de noutate a temei, obiectivele generale ale lucrării, metodologia folosită, firul roşu al lucrării (titlul capitolelor şi legătura dintre ele), precum şi limitele lucrării (confidenţialitatea datelor, rată mică de răspuns la chsetionare/interviuri, lipsa accesului la unele surse bibliografice de referinţă, etc.). Introducerea nu se numerotează ca şi capitol;
e. Capitole şi subcapitole – lucrarea de licenţă va conţine între 3 şi 4 capitole numerotate crescător. În cadrul acestora, se vor include 1-2 capitole în care se dezvoltă, în urma documentării, conţinutul temei din punct de vedere teoretic şi  1-2 capitole în care se prezintă metodologia şi rezultatele cercetării aplicative, soluţiile propuse şi argumentele autorului (studiul de caz). Se recomandă ca partea aplicativă a lucrării de licenţa să aibă ca pondere minim 40% din conţinut. 
f. Concluzii şi propuneri – în această parte a lucrării de licenţă se regăsesc cele mai importante concluzii obţinute în urma cercetării (studiului de caz), opinia personală privind rezultatele obţinute în lucrare, precum şi potenţiale direcţii viitoare legate de tema abordată. Concluziile lucrării nu se numerotează ca şi capitol
g. Anexe (dacă este cazul) – acestea apar într-o secţiune separată, care nu se numerotează ca şi capitol. Fiecare anexă se va menţiona cel puţin o dată în textul lucrării. Anexele se numerotează crescător (Anexa nr. 1, Anexa nr. 2, etc).
h. Bibliografie – acesta este ultima parte a lucrării şi va conţine lista tuturor surselor de informaţie utilizate de către absolvent pentru redactarea lucrării de licenţă. Bibliografia nu se va numerota ca şi capitol al lucrării.

CAPITOLUL 2

REGULI DE REDACTARE A LUCRĂRII DE LICENŢĂ
Formatul întregii lucrări este A4, numărul de pagini fiind între 60 şi 65 (inclusiv anexele), cu următoarele elemente:

a. Marginile paginii – se vor utiliza următoarele valori pentru marginile paginii (Page Setup -> Margins): 

· stânga: 2,5 cm; 

· dreapta: 2 cm;
· sus:  2 cm; 

· jos: 2 cm.
b. Spaţiere între rânduri – textul se va tehnoredacta la un rând  (Format  -> Paragraph -> Line spacing -> Single);

c. Alinierea şi fontul titlurilor de capitole şi subcapitole (a se vedea anexa nr. 4) –  capitolele şi titlurile acestora vor fi aliniate utilizând opţiunea center. Fontul utilizat pentru redactare capitolului şi titlului acestuia va fi Times New Roman, majuscule, bold, cu dimensiunea de 14 puncte, utilizând diacriticele specifice limbii în care este redactată lucrarea (ă, ş, ţ, î, â - pentru limba română). Titlul capitolului se va scrie la 1 rând de capitol (Capitol -> Enter -> Titlu capitol). Fiecare capitol va începe pe pagină nouă. Subcapitolele şi titlurile acestora se vor scrie la 2 rânduri de titlul capitolului utilizând opţiunea justified, indentare de 1,27 cm (Format -> Paragraph -> Indentation -> Special: First line by 1,27 cm). Fontul utilizat pentru redactare va fi Times New Roman, Normal, bold, cu dimensiunea de 12 puncte, utilizând diacriticele specifice limbii în care este redactată lucrarea (ă, ş, ţ, î, â - pentru limba română).

d. Alinierea şi fontul textului în cadrul capitolelor şi subcapitolelor (a se vedea Anexa nr. 4) – textul din cadrul paragrafelor normale (conţinutul capitolelor şi subcapitolelor) va fi aliniat utilizând opţiunea justified. Primul rând al fiecărui paragraf va avea o indentare de 1,27 cm (Format -> Paragraph -> Indentation -> Special: First line by 1,27 cm). Fontul utilizat pentru redactare va fi Times New Roman, single (la un rând), cu dimensiunea de 12 puncte, utilizând diacriticele specifice limbii în care este redactată lucrarea (ă, ş, ţ, î, â - pentru limba română). 
e. Numerotarea paginilor – numerotarea paginilor se face începând cu pagina de titlu, până la ultima pagină a lucrării, dar numărul paginii apare doar începând cu Introducerea. Numărul de pagină se inserează în subsolul paginii, centrat (Insert -> Page Numbers  -> Position: Bottom of page (Footer) -> Alignmet: Center).

f. Tabele (a se vedea Anexa nr. 4) – tabelele se numerotează cu 2 cifre, prima reprezentând numărul capitolului, iar cea de a doua reprezentând numărul tabelului din capitolul respectiv. Fiecare tabel are număr şi titlu. Numărul tabelului se menţionează deasupra tabelului, aliniat la marginea din dreapta. Titlul tabelului se menţionează la 1 rând de număr, utilizând opţiunea center. Fontul utilizat pentru redactare va fi Times New Roman, bold, cu dimensiunea de 12 puncte. Dacă este cazul, sursa datelor se precizează la notele de subsol. 

g. Figuri (a se vedea Anexa nr. 4) –  figurile (aici sunt incluse imagini, grafice, capturi de ecran) se numerotează cu 2 cifre, prima reprezentând numărul capitolului, iar cea de a doua fiind numărul figurii din capitolul respectiv. Fiecare figură are număr şi titlu, care se menţionează sub figură, utilizând opţiunea center. Fontul utilizat pentru redactare va fi Times New Roman, bold, cu dimensiunea de 12 puncte. Dacă este cazul, sursa datelor se precizează la notele de subsol. 

h. Note de subsol - în situaţia în care se citează (ex. definiţii, puncte de vedere, clasificări, etc), se menţionează cifre (ex. rata inflaţiei, poziţie în clasamente, PIB, etc.) sau se doreşte explicarea unor termeni (ex. stakeholders, formule folosite), se vor introduce note de subsol (Insert -> Reference -> Footnote -> Location: Footnotes (Bottom of page) -> Format: Number format (1, 2, 3, ...); Start at: (1) -> Numbering (Restart each page) pentru a se indica sursa(ele). Fontul utilizat pentru redactare va fi Times New Roman, single (la un rând), cu dimensiunea de 10 puncte, utilizând diacriticele. Menţionarea autorilor în textul notei de subsol se va face prin indicarea numelui şi a prenumelui. În cazul citării unui text menţionat într-o singură pagină a lucrării se va face menţiunea „p”; în cazul citării mai multor pagini din lucrare se va face menţiunea „pp”. Notele de subsol se numerotează unitar pentru toată lucrarea,  şi vor respecta următoarele reguli de citare: 
· în cazul citării din cărţi cu un singur autor: Stăncioiu, Ion – Management-elemente fundamentale, Ed. Teora, Bucureşti, 1999, p. 432 

· în cazul citării din cărţi cu mai mulţi autori: Stăncioiu, Ion; Militaru Gheorghe – Management-elemente fundamentale, Ed. Teora, Bucureşti, 1999, p. 432

· în cazul citării din cărţi cu coordonator: Nicolescu, Ovidiu (coord.) – Strategii manageriale de firmă, Ed. Economică, Bucureşti, 1998, pp. 552-557
· în cazul citării din cărţi editate în limba română dar care au fost traduse din altă limbă: Hesselbein, Frances; Goldsmith, Marshall; Beckhard, Richard – Oraganizaţia viitorului, traducere, Ed. Teora, Bucureşti, 2000, p. 114
· în cazul citării din articole publicate în reviste: Tabără, Neculai – în articolul Fundamente teoretice privind controlul de gestiune, publicat în revista “Finanţe publice, contabilitate”, nr. 11-12/2002, p. 29

· în cazul citării de articole publicate în volume ale unor manifestări ştiinţifice: Balteş Nicolae – în comunicarea Considerente privind organizarea auditului intern, publicată în Caietul ştiinţific “Reformele administrative şi judiciare în perspectiva integrării europene – Secţiunea pentru ştiinţe economice şi administrative” nr. 6/2004, Institutul de Ştiinţe Administrative “Paul Negulescu”, Ed. BURG, Sibiu,  pp. 258-269

· în cazul citării unor repere legislative, în funcţie de modificările aduse acestora: Legea nr. 672 din 19 decembrie 2002 privind auditul public intern, M.Of nr. 953/24.12.2002, cu modificările şi completările ulterioare / Legea nr. 672 din 19 decembrie 2002 privind auditul public intern, republicată, M.Of nr. 953/24.12.2002, cu modificările şi completările ulterioare / Legea nr. 672 din 19 decembrie 2002 privind auditul public intern, republicată, M.Of nr. 953/24.12.2002, cu modificările şi completările ulterioare.

· în cazul citării unor lucrări fără autor: *** – Norme naţionale de audit, Ed. CECCAR, Bucureşti, 1999, p. 65
· în cazul citării unor surse de pe internet se va scrie adresa completă şi perioada în care aceasta a fost accesată: Newing, Rod – în articolul The importance of education, 28 September 2004, http://news.ft.com.cms/s/ fcb7e488-1160-11d9-95d9-00000e2511c8,dwp_uuid=857cf036-115e-11d9-95d9-00000e2511c8,ft_acl=,s01=2.html, accesat noiembrie 2007

· în cazul citării mai multor lucrări se vor insera atâtea note de subsol câte lucrări sunt citate; numărul notelor de subsol se va separa prin virgulă.
i. Bibliografia - se structurează pe următoarele paliere: „Cărţi, tratate, cursuri, monografii”, „Articole şi lucrări conferinţe”, „Legislaţie”, „Site-uri”. Aceste liste bibliografice se vor ordona alfabetic.
Imprimarea tuturor paginilor lucrării se va realiza pe ambele feţe a fiecărei foi, cu excepţia paginii de titlu care va fi pe o singură foaie.
CAPITOLUL 3

REGULI DE PREZENTARE A LUCRĂRII DE LICENŢĂ
Prezentarea lucrării de licenţă în faţa comisiei de examinare este cel puţin la fel de importantă ca şi redactarea acesteia. Nota finală obţinută de către absolvent este şi rezultatul evaluării comisiei, în urma prezentării şi susţinerii lucrării de către absolvent.

Reguli de prezentare şi susţinere a lucrării de licenţă:

a. Momentul şi locaţia prezentării: absolvenţii vor fi anunţati asupra datei, orei şi locaţiei la care îşi vor putea susţine lucrarea de licenţă în faţa comisiei. Neprezentarea absolventului la data, ora şi locaţia stabilite poate atrage eliminarea acestuia din examenul de licenţă. 

b. Prezentare în PowerPoint: absolventul îşi va susţine rezultatele cercetării realizate cu ajutorul unei prezentări multimedia concepute în PowerPoint (Office 2003).
c. Timp maxim de prezentare: 10 minute;

d. Intrebări: membrii comisiei pot adresa absolventului oricâte întrebări referitoare la subiectul lucrării de licenţă şi/sau metodologia şi resursele folosite;

Recomandări pentru realizarea prezentării multimedia: 

· prezentarea va conţine între 10 şi 15 diapozitive (slide-uri); 
· existenţa obligatorie a unui slide de titlu, care va conţine cel puţin titlul lucrării, numele absolventului şi numele cadrului didactic coordonator; 
· slide cu cuprinsul lucrării; 
· slide-uri cu text, tabele, figuri cu ajutorul cărora se vor prezenta acele aspecte ale lucrării ce se doresc a fi comunicate comisiei; 
· 1-2 slide-uri pentru concluzii
· slide-urile nu vor conţine prea mult text (maximum 7 linii a câte 7 cuvinte fiecare), iar absolventul nu va citi informaţia de pe diapozitiv.

ANEXE
In continuare prezentăm, fiecare pe câte o pagină, şabloane pentru următoarele documente:

Anexa nr. 1: Coperta lucrării de licenţă

Anexa nr. 2: Prima pagină a lucrării de licenţă (pagina de titlu)
Anexa nr. 3: Exemplu tehnoredactare  cuprins

Anexa nr. 4: Exemplu pentru tehnoredactare conţinut lucrare de licenţă
Precizăm faptul că aceste şabloane pot fi descărcate de pe site-ul Universităţii Româno-Germane din Sibiu, putând fi utilizate de către studenţi în procesul de redactare a lucrării de licenţă.
UNIVERSITATEA ROMÂNO-GERMANĂ DIN SIBIU
FACULTATEA DE …
LUCRARE DE LICENŢĂ

Coordonator ştiinţific

Titlu Prenume Nume
(Exemplu: Conf.univ.dr. …..)
Absolvent

Prenume Nume
Anul

UNIVERSITATEA ROMÂNO-GERMANĂ DIN SIBIU

FACULTATEA DE …
Specializarea ..........
Titlul lucrării

Coordonator ştiinţific

Titlul Prenume Nume
(Exemplu: Conf.univ.dr. …)
Absolvent

Prenume Nume
Sibiu
Anul

CUPRINS
Introducere
3
Capitolul 1. Abordări teoretice de bază privind managementul

     1.1. Conceptul privind funcţiunea organizaţiei.

     1.2. Managementul între artă, ştiinţă, tehnică, limbaj

     1.3. Funcţiile managementului

            1.3.1. Previziunea

            1.3.2. Organizarea

            1.3.3. Coordonarea

            1.3.4. Antrenarea

            1.3.5. Controlul şi evaluarea

     1.4. Interdependenţe dintre caracteristicile firmei şi conţinutul managementului financiar

Capitolul 2. Economia, organizaţia şi managementul bazate pe cunoştinţe şi implicaţiile

                     lor în organizaţia viitorului

     2.1. Guvernanţa corporativă – un nou mod de conducere în secolul XXI

     2.2. Crearea unei structuri organizatorice funcţionale prin implementarea centrelor de 

            gestiune, de profit şi de performanţă

     2.3. Managementul în contextul implementării noilor tehnologii informaţionale şi de  

            comunicaţii


     2.4. Amprente culturale asupra strategiilor de dezvoltare

Capitolul 3. Studiu de caz privind implicaţiile managementului bazat pe cunoştinţe la    S.C. Ambient S.A. 

     3.1. Guvernanţa corporativă – un nou mod de conducere în secolul XXI


     3.2. Crearea unei structuri organizatorice funcţionale prin implementarea centrelor de 

            gestiune, de profit şi de performanţă


     3.3. Managementul în contextul implementării noilor tehnologii informaţionale şi de  

            comunicaţii


     3.4. Amprente culturale asupra strategiilor de dezvoltare


Concluzii şi propuneri 

Anexe (dacă există) 

Bibliografie 

CAPITOLUL 1

ABORDĂRI TEORETICE DE BAZĂ PRIVIND MANAGEMENTUL
1.1. Conceptul privind funcţiunea financiară şi rolul acesteia în  cadrul firmei. Interferenţe între funcţiunea financiară şi celelalte funcţiuni ale firmei 

Entitatea economică îşi desfăşoară activitatea într-un anumit cadru organizatoric. Ea presupune un ansamblu de activităţi dinamice şi complexe, ce se pot grupa pe anumite funcţiuni care se condiţionează reciproc şi a căror integrare permite acesteia să reacţioneze corespunzător la solicitările mediului, să evolueze eficient şi să se dezvolte continuu. Iniţiatorul conceptului de funcţiune a fost Henry Fayol (Administrarea industrială şi generală, 1916), care a realizat pentru prima oară, în baza unei analize a întregului complex de activităţi din cadrul firmei, o compartimentare, o grupare raţională a tuturor activităţilor în şase funcţiuni: tehnică, comercială, financiară, contabilă, de securitate, administrativă. Ulterior, conceptul de funcţiune a constituit subiectul a numeroase studii şi cercetări iniţiate de specialişti, suferind repetate modificări. 

1.2. Funcţiile managementului financiar
După cum specialiştii din ţară şi străinătate recunosc că există un sistem de funcţii ale managementului general, un obiectiv urmărit în cadrul lucrării a fost prezentarea şi analiza funcţiilor managementului financiar. Ele au ca fond conceptul funcţiilor managementului general şi se particularizează în zona financiară cu activităţile specifice ale acesteia (figura 1.1).


[image: image1]
Fig. 1.1. Funcţiile managementului financiar
Funcţiile managementului financiar se află într-o strânsă interdependenţă, formând un sistem, şi au un caracter dinamic. Ele apar şi se dezvoltă concomitent cu evoluţia firmei şi îşi manifestă, mai mult sau mai puţin accentuat, caracterul în diferite stadii ale dezvoltării firmei.

1.2.1. Previziunea financiară

Se constituie ca o funcţie prioritară în managementul financiar deoarece asigură o identificare previzibilă a viitorului, căutând astfel răspuns la întrebările: “ce trebuie şi ce se poate realiza în cadrul firmei?” În opinia noastră, funcţia de previziune a managementului financiar cuprinde totalitatea activităţilor desfăşurate de către manageri şi profesioniştii financiar-contabili din întreprindere în scopul stabilirii principalelor obiective viitoare ale sale, a resurselor (materiale, financiare, umane) necesare, condiţiilor de procurare a acestora precum şi a implicaţiilor determinate prin realizarea lor.
Astfel, în cadrul funcţiei de previziune se stabilesc obiectivele firmei, precum şi cele mai avantajoase căi de acţiune pentru atingerea acestora. Pe această bază se fundamentează decizia economică, plecând de la principiul evaluării variantelor decizionale în raport cu cerinţele eficienţei ridicate
.
În derularea funcţiei de previziunea a managementului financiar, profesioniştii elaborează documente contabile proforma (bilanţ contabil, cont de profit şi pierdere etc.), prognoze financiare, politici financiare, strategii financiare, planuri financiare, bugete, proiecţii privind costurile în procesul de producţie etc. utilizând indicatori de performanţă adecvaţi privind activitatea firmei cu care se dimensionează necesarul de resurse şi rezultatele obtenabile.

1.2.2. Organizarea financiară

Considerăm că funcţia de organizare a managementului financiar cuprinde ansamblul activităţilor ce trebuie efectuate pentru realizarea cadrului organizatoric optim în vederea maximizării eficienţei economico-sociale. Prin ea se stabileşte cine şi cum trebuie să contribuie la realizarea obiectivelor previzionate.
În cadrul acestei funcţii sunt incluse activităţile necesare îndeplinirii obiectivelor financiar-contabile ale firmei, aşezarea lor ca sarcini pe salariaţi şi structuri organizatorice şi statuarea tuturor acestora într-un cadrul precis conturat de adoptare şi urmărire a deciziilor. Exercitarea funcţiei de organizare a managementului financiar conduce la definirea unor domenii organizaţionale, astfel:
, 
, 

· activitatea contabilă;

· activitatea financiară;

· activitatea de control financiar propriu;

· activitatea de audit intern;
În organizare, managementul activităţii financiar-contabile ţine cont în primul rând de complexitatea activităţilor care îi sunt subordonate, de dimensiunile firmei.

CAPITOLUL 2

ECONOMIA, ORGANIZAŢIA ŞI MANAGEMENTUL BAZATE PE CUNOŞTINŢE ŞI IMPLICAŢIILE LOR ÎN ORGANIZAŢIA VIITORULUI

2.1. Crearea unei structuri organizatorice funcţionale prin implementarea centrelor  de gestiune, de profit şi de performanţă. Implicaţii în managementul activităţii financiar-contabile a firmei

Considerăm că funcţionarea firmei pe criterii de eficienţă, se bazează pe divizarea acesteia în centre de gestiune, de profit şi de performanţă, caracterizate prin obiective şi mijloace proprii sau, altfel spus, printr-o autonomie decizională privind utilizarea unei părţi din resursele alocate, în cadrul politicilor stabilite. 

Activitatea unui astfel de centru defineşte limitele în care se exercită atribuţiile şi responsabilitatea unui manager. Fiecare din funcţiile sale (figura 2.1) se manifestă la nivelul fiecărui centru într-un mod mai eficient deoarece, este mult mai uşor de realizat previziuni, de stabilit obiective, de organizat, de coordonat, de urmărit o secţiune mai restrânsă în comparaţie cu o întreagă organizaţie. Responsabilităţile vor fi mai clar delimitate, informaţiile vor fi obţinute mai uşor, încărcarea posturilor se va face la nivel de centru şi nu de firmă.
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Fig. 2.1 Obiectivele managementului activităţii financiar-contabile la nivel 
de centru de gestiune, de profit şi de performanţă

În opinia noastră considerăm că un avantaj esenţial în managementul activităţii financiar‑contabile este măsurarea performanţelor, informaţiile financiar-contabile fiind analizate atât la nivel de centru cât şi la nivel general. La nivel de centru, managerul centrului se va ocupa de colectarea datelor, structurarea acestora şi transmiterea lor la direcţia financiar‑contabilă generală a firmei. Managementul financiar are mai multe opţiuni de cuantificare a performanţei
, în funcţie de ceea ce se urmăreşte (tabelul 2.1).

Informaţiile astfel obţinute vor fi analizate atât separat, în conformitate cu obiectivele stabilite pentru fiecare centru, cât şi la nivel general, în conformitate cu obiectivele şi strategia firmei. 

Un alt avantaj important pentru managementul activităţii financiar-contabile vizează controlul. Fie că este vorba de controlul financiar preventiv, de controlul de gestiune sau un alt tip de control financiar propriu, considerăm că managementul financiar va fi mai eficient în situaţia în care controlul va fi organizat la nivel de centru, neregulile fiind mai uşor de observat şi de soluţionat. 

Tabelul 2.1

Măsurarea performanţei centrelor de gestiune, de profit şi de performanţă

	Obiective urmărite
	Criterii cantitative şi calitative de măsurare a performanţei utilizate de managementul financiar

	Costuri
	Mărimea costurilor individuale; abaterile de cost; abaterile de preţ; costul unitar; ratele privind costul; costul pe salariat; nivelul cantitativ al producţiei etc.

	Venituri 
	Cifra de afaceri; analiza cifrei de afaceri în corelaţie cu capacitatea de producţie şi cererea etc.
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C. Legislaţie
Previziune financiară





Managementul  financiar





Organizare financiară





Coordonare financiară





Antrenare





Control, audit şi evaluare





Previziune





Organizare





Coordonare





Antrenare 





Control-audit





fundamentarea politicii şi strategiei;


bugete;


situaţii financiare  previzionale etc.








operaţionaliza-rea şi soluţionarea problematicii asigurării, alocării şi controlului utilizării resurselor.


evidenţe proprii;


analize proprii etc.











delegarea responsabilităţi;


comunicarea cu celelalte centre şi cu managerii de top;


caracterul oficial al comunicării financiare etc.











stabilirea drepturilor personalului conform cu performanţele;


programe de perfecţionare şi motivare;


variante şi soluţii de optimizare decizii etc.











control financiar propriu la nivel de centru;


audit intern la nivel de centru;


feed-back etc.
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